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 Important notice 

In the new software version 7.4.3 we have updated the Modbus drivers of the following products: 

EM24 
WM14 
CPA300 
CPT 

This means that if a configuration has been generated with 6.5.33 or previous software versions, when 
it is updated to 7.4.3 or later releases, the energy meters must be deleted and then added again. 
If this procedure is not executed, they will show "Updating" in live signal and the communication will fail. 

 

 Guidelines  

 System features 

¶ Up to 5000 managed signals (including variables, I/Os) shared among Energy Management, 

Building Automation and Car Park applications. 

Note: when the Car Park system is active, there will be 2000 signals available for the other applications 
(Energy Management and Building Automation). 

¶ up to 128 Modbus devices connected to RS485 ports (64 devices each port) 

¶ up to 5 users concurrently connected to the Web-App 

¶ up to 5 concurrent M2M connections (API connections, BACNET clients, MODBUS masters) 

¶ up to N different products from the CG range can be connected to UWP 3.0. 

 Best practises 

¶ avoid enabling events logging for analogue variables as they can quickly fill the database 

¶ the use of Park guidance functions together with data push functions is not allowed by UWP 3.0 

¶ avoid sending to UWP 3.0 frequent and/or huge data requests via Rest-API, as they can overload 

UWP 3.0 

¶ avoid sending to UWP 3.0 frequent and huge data requests via MODBUS or MODBUS/TCP or 

BACNET, as they can overload UWP 3.0 

¶ avoid mixing in the same UWP 3.0 big Car Park installations with big Building Automation 

installations; use different controllers for different responsibilities 

¶ remind that direct data connection between UWP 3.0 units or between UWP 3.0 and VMU-C EM or 

UWP 3.0 and Sx2WEB units should be used for few variables, as the MODBUS/TCP 

communication is done variable by variable; in the case of multiple variables reading it is strongly 

suggested to create a driver via the MODBUS DRIVER EDITOR tool. 

 Function status 

To reduce the number of Dupline channels, from the software release 7.4.3, in the functions listed below, 

if some fields in the Advanced section are used, it is mandatory to enable the relevant status in the 

Available output status field.  

List of functions: 
Á Dupline Temperature regulation 
Á Smoke alarm 
Á Water alarm 
Á Counter 
Á Analogue output 
Á Hour counting 
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Á Car Heating 
Á Mathematical function 
Á Zone temperature (when PID advanced is used) 
Á On/Off pump function 

 
If this is not done, an error will occur during compilation process. The table below shows the status which 
needs to be enabled. 
 

 
 
 

 
  

Function Field Output-input link Additional output to be enabled

Advanced/Heating Dupline: Temperature regulation.Heating

Advanced/Cooling Dupline: Temperature regulation.Cooling

Smoke alarm Advanced/Reset alarm Smoke alarm.Reset active

Water alarm Advanced/Reset alarm Water alarm.Reset active

Counter Feedback Counter function.Feedback status

Analogue output Output signals Analogue output.Output value after a reset command

Hour counter Alarm status output Hour counter.Alarm status

Car heating Feedback signals Car heating.Feedback

Average input value + offset Mathematical function.Input values average + offset

Minimum input value Mathematical function.Minimum input

Maximum input value Mathematical function.Maximum input

A input ï B input Mathematical function.A input ï B input

Average input value + offset, linearized + output 

offset

Mathematical function.Average input value + offset, 

linearized + output offset

Linearized minimum value Mathematical function.Linearized minimum value

Linearized maximum value Mathematical function.Linearized maximum value

Advanced/Analogue output signals/Heating Zone temperature.Analogue output for heating

Advanced/Analogue output signals/Cooling Zone temperature.Analogue output for cooling

On/Off pump function Output signals On/Off pump function.Status

Dupline Temperature 

regulation

Mathematical function Output signals

Zone temperature (with 

analogue PID regulation)
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 Legacy products 

UWP 3.0 integrates all the functions that are available with the four controllers described below. 
In order to provide a complete information, the following table describes the differences among the legacy 
products.  

 Differences among the four controllers SH2WEB24, SB2WEB24, SA2WEB24, SBP2WEB24 

 SA2WEB24 SH2WEB24 SB2WEB24 SBP2WEB24 

 
Hotel/Flat Home Building Building &  

Car-park 

Database History (dmd common to all variables) ¶ ¶ ¶ ¶ 

Event ¶ ¶ ¶ ¶ 

Scheduler mail report ¶ ¶ ¶ ¶ 

Scheduler ftp report ¶ ¶ ¶ ¶ 

Remote Mail notifications ¶ ¶ ¶ ¶ 

Sms notifications  ¶ ¶ ¶ 

Sms commands  ¶ ¶ ¶ 

Light light ¶ ¶ ¶ ¶ 

dimmable light ¶ ¶ ¶ ¶ 

constant light ¶ ¶ ¶ ¶ 

dimmer sequence ¶ ¶ ¶ ¶ 

Motor roller-blinds ¶ ¶ ¶ ¶ 

tilting blinds ¶ ¶ ¶ ¶ 

open close window ¶ ¶ ¶ ¶ 

Temperature zone temperature ¶ ¶ ¶ ¶ 

heating system temperature ¶ ¶ ¶ ¶ 

cooling system temperature ¶ ¶ ¶ ¶ 

Alarm zone intruder alarm ¶ ¶ ¶ ¶ 

main intruder alarm ¶ ¶ ¶ ¶ 

smoke alarm ¶ ¶ ¶ ¶ 

water alarm ¶ ¶ ¶ ¶ 

siren alarm ¶ ¶ ¶ ¶ 

Timer delay timer ¶ ¶ ¶ ¶ 

recycling timer ¶ ¶ ¶ ¶ 

interval timer ¶ ¶ ¶ ¶ 

Basic calendar ¶ ¶ ¶ ¶ 

sequence ¶ ¶ ¶ ¶ 

multi-gate ¶ ¶ ¶ ¶ 

counter  ¶ ¶ ¶ 

analogue comparator ¶ ¶ ¶ ¶ 

mathematical  ¶ ¶ ¶ 

PID control  ¶ ¶ ¶ 

modbus output bridge  ¶ ¶ ¶ 

remote modbus variable  ¶ ¶ ¶ 

analogue outputs  ¶ ¶ ¶ 

hour counting  ¶ ¶ ¶ 

on/off pump  ¶ ¶ ¶ 

on/off pump group  ¶ ¶ ¶ 

analogue command for twin pumps  ¶ ¶ ¶ 

analogue command for groups of pump  ¶ ¶ ¶ 

Car park 
Data pointer    ¶ 

Master zone counter    ¶ 

Car park sensor    ¶ 

Car park display    ¶ 
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Fast display update    ¶ 

 
Location Line, Lane, Level    ¶ 

Special Car heating ¶ ¶ ¶ ¶ 

simulated habitation ¶ ¶ ¶ ¶ 
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 Report sent using the email 

Starting from version 7.4.31, the configuration of emails with reports, can be done only by means of the 
web-app.  
 

1) Open the report menu 
 

 
 
 
 
 
 

2) Configure the email account if it was not configured using the tool 
 

  
 
 
 
 
 
 
 
 
 
 

3)  Link the report to be sent 



 

 

UWP 3.0 tool manual  

20 

 

 

 

 
 
 
 
 
 
An Email function generated with a former version of the software is not converted, so the user 
has to do it manually. 

  



 

 

UWP 3.0 tool manual  

21 

 

 

 Introduction 
The UWP 3.0 tool has been developed for the configuration of the UWP 3.0, a programmable Linux 
embedded PC specially designed for home automation applications. 
All demotic functions are represented by graphic symbols, and all function related parameters are set up 
locally in the PC, and then transferred to the UWP 3.0 via Ethernet. Some of the function parameters can 
be changed later via remote connection to the controller (web server, email, sms, Modbus,.. ) as described 
later in this manual. 
Likewise, data from the UWP 3.0 can be uploaded and modified. 
 
The PC does not need to be connected to a UWP 3.0 controller in order to make a configuration. 
 
The figures in this manual may differ from the figures on your screen. This is not necessarily an 
error, but may be caused by revision differences. 
 
The contents of this manual may be altered without notice. 
 

 Requirements 

 Minimum hardware requirements 

¶ A Microsoft® Windows®-based PC 

¶ Display with a resolution capability of minimum 1024x768 pixels 

¶ 1 GB of disk-space 

¶ An Ethernet-port and cable or SD-card reader or USB port 2.0 or higher 
 

 Software requirements 

¶ Microsoft® Windows® 10/8.1/8/7/Vista (32 or 64-bit) 

¶ Microsoft Dot-Net Framework 4.5 
 

 How to read the software version number 

The UWP 3.0 tool revision number has the following structure: 
 

Major Minor Sub minor Revision 
 

¶ Major: this identifies the main features of the software. It is incremented when new features are 

added or there are big changes in the existing ones. 

¶ Minor: this identifies the version of the relevant major release and it is incremented when there 

are small new functions and bug fixing. 

¶ Sub minor: this identifies the version of the relevant major release and it is incremented when 

there are bugs fixing 

¶ Revision: this identifies the status of the release. 

1  beta: for internal use only  
2  controlled beta: to be shared with selected customers for field testing 
3  final: available for everybody on the Carlo Gavazzi website 
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 Installation 
The UWP 3.0 tool can be downloaded from Carlo Gavazziôs Product Selection website. To install the 
software you just have to double click on the Setup.exe file and follow the instructions on the screen. 
 
In order to get in contact with the UWP 3.0 controller, the user has several connection modes available: 
 
via Ethernet connection 
via Mini USB cable 
via Modem connection  
 
 
After a power on, the UWP 3.0 master unit is ready to work after about 1 minute. Only when the yellow 
BUS Led starts flashing is the master unit ready. 
 

 How to connect the master unit UWP 3.0 with Ethernet connection 

 
To connect to a master unit UWP 3.0, the user has to click on the icon highlighted in red in the picture 
below: the UWP 3.0 tool will start the discovery of the UWP 3.0 connected to the Ethernet network. 
 

 
 
 
Important note 
If the PC is running the Windows Firewall or a Third party Firewall / Antivirus, make sure that the ports 
52325, 10000, 10001, 10002, 80 and 443 are not blocked (input/output packets). These ports are used 
by the UWP 3.0 Tool to search for the master unit in the network and for communication. If a firewall 
blocks these ports, the UWP 3.0 Tool will not be able to find the controllers in the network or to use the 
Live Signals. 
Be sure that the master unitôs IP settings match the IP settings of the PC used: it must have the same IP 
class and the same net mask address. 
 
When the PC has more than one network card or has many IP addresses, it is possible to select the right 
network from the list (see picture below): it must be the same one as the UWP 3.0 is connected to. 
 

 
 
When the icon marked in red is clicked, the UWP 3.0 Tool starts looking for the controller(s). If one or 
more units are found, a window will pop-up, allowing you to make a selection of which controller to connect 
to. 
 
Select the required master unit on the list or Cancel if you do not want to get connected at this time. 
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After the user has pressed Connect, the red Led on the selected UWP 3.0 starts flashing and the 
connection will be established. 
 

 
 

 How to connect with a mini-USB cable  

 
The UWP 3.0 controller can be connected to the PC by means of the mini-B port available on the front of 
the housing, protected by the front cover. Please refer to the Hardware manual for technical information. 
 
The following items are required to obtain the connection: 
 
A USB 2.0 cable-Type-A / Mini-B (this is not provided with the UWP 3.0 controller).  
 
mini-USB driver.zip package available on www.productselection.net website in the UWP 3.0. 
 
The driver installation procedure can change slightly depending on the operating system in the userôs PC: 
please follow the instructions below. 
 
  

http://www.productselection.net/
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 How to install the mini-USB driver for Windows 7 / Vista / XP 

Open the archive ñmini-USB driver.zipò and save the file linux.inf in your PC, then install the driver 

by following the instructions below: 

1. Plug the USB connector into a free USB port of the PC and the mini-USB connector into the mini-

B port of the UWP 3.0  

2. Go to Control Panel and open Device Manager.  

3. Find the device RNDIS/Ethernet Gadget, right-click on it and select Update Driver 

Softwareé, as shown in the picture below. 

 

 

4. Select the Browse my computer for driver software option.  

 

5. Browse for the linux.inf driver file and press OK. 
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6. The driver Linux USB Ethernet/RNDIS Gadget will be detected: press Next to proceed. 
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7. The driver will be installed, as shown in the picture below. 

 

 

 

8. When the driver is installed, in the Network adapter category a virtual network board named Linux 
USB Ethernet/RNDIS Gadget will be added, as shown in the picture below. The driver 
automatically gives a dynamic IP address to the Controller/PC according to the actual IP of the 
PC. 

 

 

For example, if the PC has the IP address 192.168.0.10, the virtual board will be created with a 
new address 192.168.254.xxx and the IP address 192.168.254.254 will be assigned to the UWP 
3.0 controller. 
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9. Insert the IP address 192.168.254.254 in the UWP 3.0 Tool and press Connect, as shown in the 
picture below: 

 
 

 

 How to install the mini-USB driver for Windows 10 / 8.1 / 8 

 

1. Open Windows 10 Control Panel by right-clicking on the Start button  and click on Control 

Panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In View by: Small icons,  click on Device Manager. 
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3. Before connecting the mini-USB cable to the PC and to the UWP 3.0 controller, in the list of 

hardware categories double-click on the category Ports (COM & LPT) and take note of the serial 

communication (COM) ports in use. In the example shown below, the only serial communication 

port is COM1. 

 

 

 

4. Plug the mini-USB cable into the PC and into the UWP 3.0 controller. A new serial communication 

port (COMx) will automatically be added after a few seconds. In the example shown below the 

new port added is COM4. 
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5. Right-click on the device and select Update Driver Softwareé 

 

 

 

6. In the pop-up window, select the second option, Browse my computer for driver software 
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7. In the next page, select the option Let me pick from a list of device drivers on my computer 

 
 
 

8. Browse for the linux.inf file, save it in the PC and press Open 
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9. Press OK in the next window, as shown in the picture below 
 

 
 
 
 

10. The Linux USB Ethernet/RNDIS Gadget is ready to be installed. Click on Next to continue the 
installation.  
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Follow the instructions below to disable driver signature enforcement ONLY if the user gets the error 
shown in the picture below, otherwise go to step 11. 
 
 

 
 
 
Windows 10 enforces driver signatures by default. This can be disabled to install drivers that are not 
digitally signed. Please refer to the following steps to disable driver signature enforcement. 
 

1. Click the Start  menu and select Settings. 
 

2. Click Update and Security. 
 

3. Click on Recovery. 
 

4. Click Restart now under Advanced Startup. 
 

5. Click Troubleshoot. 
 

6. Click Advanced options. 
 

7. Click Startup Settings. 
 

8. Click on Restart. 
 

9. On the Startup Settings screen press 7 or F7 to disable driver signature enforcement. 
 

10. The computer will restart and the user will be able to install non-digitally signed drivers. 
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11. N.B. Windows 10 does not detect the Digital signature, so to install the driver correctly, 
click on Install this driver software anyway. 

 
 
 

12. When the driver has been installed, in the Network adapter category a virtual network board 
named Linux USB Ethernet/RNDIS Gadget #2 will be added, as shown in the picture below. 
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13. The driver automatically gives a dynamic IP to the Controller/PC according to the actual IP of the 
PC.  

For example, if the PC has the IP 192.168.0.10, the virtual board will be created with a new address 
192.168.254.xxx and the address 192.168.254.254 will be assigned to the UWP 3.0 controller. 

 

The user can type the IP address 192.168.254.254 in the address bar and click Connect. The 
green circle icon appears in the left part of the address bar when the connection is established, as 
shown in the picture below. 
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 User interface 
When the UWP 3.0 tool starts, the following window appears: 
 

 
 
The user interface uses the standard ribbon tool often used by a lot of software nowadays. To access a 
ribbon, just click on the relevant menu. 
 
 

 File Menu 

 

 
 
In the File menu the user can create a new project, open an already existing one or save it as in a standard 
menu File. 
In addition, some functions strictly related to the connection with UWP 3.0s are available and listed here: 

- Compiling a project 
- Uploading/downloading of a project  
- Discovery functions of the UWP 3.0s and modules connected in the network. 
- Enabling/Disabling of Live signal monitoring 
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The user can access the menu file either with the quick menu in the upper part of the window on the 
right of the red Carlo Gavazzi triangle or by clicking on the triangle.  
 

 
 

 View Menu 

In the View menu, the user can configure the preferred position of the windows relevant to Locations, 
Modules, Signals, Functions and Subnet. It can also remove the contents view.  
 

 
 
The windows are floating and can be positioned by using the five docking areas shown in the figure below. 
The position of the windows can be saved. 
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 Reports menu 

In the reports menu, five different kinds of reports can be created, saved and /or, printed. 
The user can select from: 

- Modules list: the complete list of modules is shown. 
- Bill of materials: the list of modules is organized by type of modules. 
- Function details: each function is described with the details of used signals. 
- Subnet usage: this report indicates the number of used signals and the total current consumption. 
- Modbus TCP/IP report: in this report the Modbus map of the project is reported. 

 
 

 
 

 

 Add menu 

In the Add menu the user can select what to add: bus extension, modules, locations and functions. 
 

 
 

Bus generators: if a new Dupline network is needed, a new bus extension module has to be added. 
Module: a new module is added (light switch, PIR sensor, output module, etcé) 
Location: The user has to define floors, rooms or any other type of location to have a clear structure of 
the installation. 
Functions: some predefined functions can be defined and configured by means of the wizard tool. The 
predefined functions are: 
 

- Lights & scenario 
- Up and down control: for controlling blinds, curtains, windows 
- Temperature System Functions 
- Alarm: intruder, smoke, water, siren 
- Calendar: can execute activities during the year 
- Sequence: executes a list of chosen functions 
- Dimmer sequence 
- Timers 
- Basic functions: this section contains Counter, Logic Gates, Analogue comparator, Mathematical 

function, Analogue output, Hour counter 
- Simulated habitation: records and then plays back the light activations 
- SMS setup: manages the SMS for the remote control of functions 
- Email 
- Car heating 
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 Program setup menu 

In the Program setup menu, the user can configure the settings relevant to a specific project, the general 
settings of the installer, the IP address and time and date of the UWP 3.0. The user can also update the 
firmware and configure the webserver and the password to access the controller. 
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 Project structure 
In a project the user has to define the locations of the house/building, add the required modules (light 
switches, movement detectors, output modules, é) and place them in the relevant location, then create 
the functions. 
Location, modules and functions are the pillars of the project structures: they are described in detail in 
the following paragraphs. 
 
 

 Wizard 

Each object, whichever type it is, is created and configured by means of the Wizard tool. 
 

 
 
The wizard is a tool that drives the user in the configuration of an object, guiding them in small steps to 
the complete setup of a module, location or function. The aim of the wizard is to reduce the effort of 
understanding the complete process of a configuration, making it easy and fast. The different steps can 
be filled in one by one just by clicking on the ñ>>>ò button and going through all of them, or by clicking on 
those required visualized in blue in the area on the right (Area 1). 
 
In the picture above an example of the wizard tool divided into three areas is shown. 
 

 Area 1 

Area1 is divided into two sections. The one on top contains the basic signals/settings the user has to 
insert/define to create the object (óobjectô is a general word to indicate location, modules or functions).  
For example, in a light function the basic signals are the input and the output signals, which are the 
minimum settings required to create this kind of function. In general, most functions show the input and 
output signals in the basic settings. 
 
In the lower section the ñAdvancedò functionalities are editable: if they are not enabled they are hidden to 
the user in order to give an easy user interface to the not-so-skilled installer. 
The list of Advanced functionalities will appear: tick the relevant box to enable the one required. For 
example, if the Lux sensor is to be used, click on this. Once the complete list disappears, by clicking again 
on Advanced, the enabled one/ones will appear for quick access. 
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 Area 2 

This is the area where signals have to be added. By double clicking on this area, the following window 
will appear. All the available signals and functions will be shown, giving the user the possibility of selecting 
one or more of them by checking the relevant row and clicking on Confirm. 
 

 
 

  Signal window filters  
Different filters can be used according to the icons at the top of the window, as shown in the red rectangle 
in the picture below: 
 

 
 
The available filters are listed in the tables below. 
 
 

Search box The results will include all words that contain the specified 
string related to the signals from the modules available in 
the current project. 

Location Only the modules that are part of the selected location will 
be shown, i.e.  the modules installed in Cabinet. 

Hide used output signals The output signals already used in at least one function, will 
be hidden 

Signals All the signals from the modules available in the current 
project will be shown in the signals window. 

Functions All the functions available in the current project will be 
shown in the signals window. 

Diagnostics All the diagnostic signals from the modules available in the 
current project will be shown in the signals window. 

Group by functions 
and modules 

The signals and functions are grouped according to the 
module they belong to. 

Group by subnet The signals are grouped according to the network they 
belong to (e.g. SH2MCG24, SH2WBU230N, SH2DUG24 
or COM port). 
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 Area 3 

This is the area where signals are configured. The user can modify the signal settings and view the 
properties of each signal (for example the long activation time of one light switch, or the sensitivity of a 
motion detector). 
 

 
 
If a note is added in the Notes tab window, a small green rectangle will appear to indicate this. By selecting 
this with the mouse, a tool tip is shown with the added note. 
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 Locations 
In the Locations window the user can define the structure of the project, starting from the locations 
where modules and functions have to be placed: the user has to define floors, rooms or any other type 
of location to have a clear structure of the installation. 
 
 

 
 
 
From the Locations window, the user can select which locations have to be shown or not: all the modules 
and functions related to the locations will be hidden/shown depending on the locations selected in the 
project tree. 
 
Click on the plus sign (+) to expand a Location and to see its sub-locations and modules: 
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 How to add a location 

 
There are different ways to create a location tree: 
 

1) Starting from the Add menu from the top menu or by right clicking in the Location window 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
When the user inserts a new location, the following Wizard window will appear. 
With this window the user can select the name of the Location and the Location family, and a short 
description of the Location can be added. 
 
When the Confirm button is pressed, the Location is inserted into the Locations tree. 
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The Location field is available for all functions of  the UWP 3.0 Tool, under the Advanced menu of the 
Wizard, as shown  below: 
 

 
 
 
 

2) In a faster way, the location tree can also be generated starting from the Discovery manager 
window: to open this, follow these steps. 

 
a) Connect to the controller 

 

 
 
 

b) Launch a discovery of the Dupline module  
 

 
 
 

c) The Discovery manager window will appear: 
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On the left of the window (marked in red), all the modules connected to the bus are prompted once the 
Scan networks push button is pressed. 
 
The Quick scan button will list only the modules of the configuration written into the UWP 3.0, 
while the Scan networks button will list all the modules connected to the controller. 
 
On the right, the location tree is shown. To generate this, only three push buttons have to be used: 
 

 
To delete a location and all its objects, the push button with the basket has to be used 
 
 
 
This stops any running activity such as a network discovery or an automatic addressing 
 
 
This adds any type of locations. It is not enabled if a module is selected. 
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 How to manage Locations  

From the Location window, the user can select which locations have to be shown or not: all the modules 
and functions related to the locations will be hidden/shown depending on the locations selected in the 
project tree. 
 
Click on the plus sign (+) to expand a Location and to see its sub-locations; in the example shown below, 
the rooms Kitchen, Bathroom, Livingroom and Cabinet are parts of the First Floor. 
 

 
 
 
The checked box next to each Location indicates that it will be shown by default. The user can choose 
which Locations to show or to hide by clicking on the relevant symbol.  
 

¶ To show the modules and functions associated to a location, the check box must remain checked 
 

¶ To hide the modules and functions associated to a location, the user has to uncheck the location. 
The objects associated to its sub-locations will also be hidden. 

 
Example 
In the picture below, the location Livingroom is on óunselectô: all the relevant modules and functions are 
hidden. 
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 Functions and modules view 

By a right click on a location the contextual menu will appear: the user can choose one of the available 
view options to easily find which are the objects in the selected location. 
 

 
 
Show objects/functions in this location 
The modules and functions in the location are highlighted in green. 
 
Show objects/functions in linked locations 
The modules and functions in all the locations or sub-locations linked to the one selected are highlighted 
in green. 
Show also objects/functions in this location 
The modules and functions used in more locations are highlighted in green. 
 
Show also objects/functions in nested locations 
The modules and functions in the locations nested into the one selected are highlighted in green. 
 
The UWP 3.0 Tool automatically highlights the location and all the modules that are used in the selected 
location. 
 



 

 

UWP 3.0 tool manual  

48 

 

 

 
 
Example 
When more locations must be highlighted, the user can select the option Show also objects/functions in 
this location. In the example shown below, the objects and functions related to Livingroom are already 
shown; if the user right-clicks on Kitchen and selects Show also objects/functions in this location, 
 

 
 
All the modules and functions that are part of Kitchen will be shown, together with the modules and 
functions of Livingroom, as shown in the picture below: 
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 Delete operation 

When the user selects the total delete action (delete), a confirm message will be displayed on the screen 
so that the user can proceed with the deleting operation. 

 How to delete a Location  

Deleting a Location implies deleting also the sub-Locations nested within it, as shown in the example in 
the picture below: 
 

- By deleting the Wall location, also the Cabinet sub-location nested within it will be automatically 
deleted. 
 

- By deleting the Floor 1 location, also the Hall and Bedroom sub-locations will be automatically 
deleted. 

 

 
 
When the user selects a location with the aim to delete it using the right mouse button, he can decide 
between two actions: 
 

- Delete: implies deleting the location (and the nested sub-locations) together with all the objects 

contained within it; all the functions and the modules assigned to the deleted locations will be 

removed; if the modules/functions being deleted are used as signals in other functions, the 

signals are to be deleted.  

-  

Delete while keeping objects:  delete the location and move all the modules and functions being 

connected to it (and to the nested locations) in the upper location (in the father node). If, as an 

example, the user decides to delete the Bedroom location, then all the modules and the functions 

being connected to it will be automatically moved to the father location Floor 1; Whereas, if the 

user deletes the Floor 1 location, then all the modules and the functions present in the Floor 1 

location and in all the locations nested within it, in this case Hall and Bedroom, will be 

automatically moved to the Root father location (there is no limit in the deepness of the nested 

Locations, all of them have to be considered).  
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 Delete commands 

The two available modes to delete a location are: 
 

1) Right mouse button and select an action to perform between the two actions being listed above. 
 

2) Delete key on the keyboard. 
 

If the user uses the right button, he can decide what kind of action to carry out (deleting all the objects or 
not); whereas if he uses the Delete key on the keyboard, then the total delete action will be automatically 
applied. It is also possible deleting only one selected location at a time (together with all its nested 
Locations).  

 How to delete a module 

The user can delete a module by using the right mouse button or the Delete key on the keyboard. When 
the user deletes a module, then all the signals coming from the deleted module and being linked to the 
functions will be automatically removed from the functions. It is possible to delete only one module at a 
time. 

 How to delete a function 

Deleting a function works like deleting the modules: 
The user can delete a function by using the right mouse button or the Delete key on the keyboard. Once 
deleted, the signals which were used by the function is freely available again; moreover, if the function 
being deleted was linked to other functions, then it must be removed. It is possible to cancel only one 
function at a time.  
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  Copy and Paste operation 

The concept of Location within the program must be explained first in order to better understand the 
concept of copy and paste operations.  
A location is a logic structure able to contain other objects and it must be considered as a folder where 
other sub-folders can be contained together with files of various kinds.  
The main feature for the Locations being defined in the UWP 3.0 Tool must be that they are not linked 
among each other by any hierarchic order; it must be possible to enter any kind of Location in any point 
of the installation whatsoever.  
This concept guarantees the highest possible flexibility to various installers when they have to create 
logically structured configurations which may be completely different depending on the case. Should a 
priority be given to the way of entering the Locations, it would result restrictive to the installers. 
There are 12 selectable locations that are respectively: 
 

- General 
- House 
- Building 
- Floor 
- Flat 
- Rooms 
- Room 
- Walls 
- Wall 
- Cabinet 
- Box 
- Garage 

 
From the userôs point of view, all the Locations must differ from each other only for their pre-defined name 
and for the image of the icon being used.  

 How to copy and paste a Location 

The copy and paste operation of a Location becomes an added value when the user has previously 
created a part of the project, such as for example a flat, and he wants to copy it instantly to create an 
apartment block made of flats similar to the starting copy. When the user copies a selected location, he 
also automatically copies all the sub-locations nested within it. As shown in the example in the picture 
below, by copying the location First floor, also the sub-locations Bedroom, Hall and Box will be 
automatically copied. Once the copy has been pasted, also the hierarchy being used by the Locations of 
the copy are maintained. 
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When the user copies a location (and the locations being nested within it as a consequence), then a copy 
of all the objects contained in the Location must be created; after that, the user must copy the name of 
all the Locations together with the signals linked to it as well as all the modules being present with all the 
relevant values set in the parameters of each module.  
 

 Names of the objects being pasted  
 
The pasted Locations must be renamed by adding to the name of the location the suffix ñ.numberò, and  
the number will progressively increase according to how many paste operations are being carried out.  
The modules must be pasted and renamed using the same method being used to enter more than one 
module to the ñmodulesò added window, and their names must be of the following kind: 
K+number+partNumber, the number of which will start from the first being available and will progressively 
increase according to how many paste operations are being carried out.  
The pasted functions must be renamed by adding to the name of the function the suffix ñ.numberò, and 
the number will progressively increase according to how many paste operations are being carried out.  
See the following example. 
 
Examples of copy and paste 
 
The example shown in the picture below explains how the copy and paste function must be carried out. 
Letôs suppose to have a simple Location named ñLocation roomò, including a Light function, a zone 
temperature function and a light switch module.  
 
ñLight1ò has as input: 

- A signal coming from the first push button of the light switch ñK1 B4X-LS4-Uò being present in 
the same Location;  

- A signal coming from the second push button of a module external to the copied Location, Light 
Switch2; 

- The function Zone Temperature TZone1 has as input: 
- A signal coming from the fourth push-button of the light switch ñK1 B4X-LS4-Uò that is situated in 

the same Location; 
- A signal coming from the function TSystem heat external to the copied Location; 

 

 
 
 
When the new location is pasted, the functions will have the following specifications: 
If the user links to the function any signals coming from a module present in the copied Location, a new 
copy of the function will be generated with another module which will be automatically re-generated. 
As for all external links having copied and pasted functions, they are kept always the same. 
In the example shown above, therefore, the first paste will generate Location Room1, in which there will 
be a true copy of the functions Light1 and Tzone1, that will be however linked to a new module internal 
to the location named ñK2 B4X-LS4-Uò, while the same external links will be kept with the function 
TSystem heat and the module Light Switch2. 
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As for the modules not being used in the Location or not being linked to functions external to the copied 
Location (see K10 B4X-PIR90), they must be treated in the same way, that is when pasting, they must 
be regenerated without any link (only module without connections). 
 
When a Location is pasted, the pasted modules that are regenerated must occupy the same subnets of 
the starting modules, modules belonging to different subnets must maintain the same original subnets, 
moreover if the copied location contains a MasterGenerator, its copy must enter a new master and re-
generate all the new modules assigning them to the new MasterGenerator being created. 
 
The example in the figure below shows what has been previously said.  
In the location that must be copied, the user can find the modules K2 B4X-LS4-U, K3 B4X-LS4-U, K4 
B4X-LS4-U belonging to Subnet1, moreover there is a MasterGenerator also belonging to Subnet 1.  
In the location there is also the module K6 B4X-PIR90 that is assigned to Subnet 2 and the modules K11 
B4X-LS4-U e K10 B4X-PIR90 that belong to Subnet 3. 
When the location is pasted, the MasterGenerator will be substituted with a new MasterGenerator 
assigned to the first free subnet, in this case Subnet 4, and all the modules that before referred to Subnet 
1 are being regenerated with reference to the new subnet, that is Subnet 4.  
The modules present at the copied location that refer to Subnets 2 and 3 are generated maintaining 
always the reference to the same subnet. 
When the user pastes a Location having some MasterGenerators, a control must be done before the 
operation in order to make sure not to enter more than 7 masters. Should there already be 7 
MasterGenerators in the configuration, then only the locals will be inserted without adding further masters. 
 

 
 
Concerning the number of modules that can be placed in a subnet, when the number of pasted modules 
exceeds the maximum number, then the user will see the circle on the right of the tree changing colour 
and becoming red. Regarding all the modules having an invalid address (since they exceed the number 
of modules being admitted by the subnet), the lack of available channels will be reported during the 
compiling phase and therefore it is the user who will manually place the subnet for each single module, 
as shown in the picture below: 
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 Modules 
 
To configure a module, the user has to click on the picture of the module in the Modules window of the 
UWP 3.0 Tool (see the picture below): 
 

 
 
 

 How to manage the filters in the Modules window 

The modules can be sorted or filtered by the Filter options: by clicking on the   icon, the Filter options 
panel will be opened. The available filters are shown in the top of the Modules window, as shown in the 
red rectangle:  
 
 
 
 
 
Only the modules specified by the filter will be presented: the filters can be used individually or they can 
be mixed. 
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Up/Down arrows:  
Once a module is selected, by clicking on the arrows it can be moved up or down. 
 

 
 
Show only highlighted modules: 
When this filter option is checked, only the modules that are highlighted (according to the highlight 
functionality available on Locations/Functions window) are presented in the Modules window. 
In the picture below an example is shown: 
 

 
 
 
Group by subnet: 
The modules are grouped by: 
 

- Mastergenerator (each network generated by SH2MCG24, SH2DUG24 and SH2WBU230N); 

- Modbus serial communication port (COM1MASTER or COM2MASTER); 

- TCP/IP Modbus connection 
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Group by location: 
The modules are grouped by the locations defined in the project. 
 

 
 
Search box: 
The results will include all the words that contain the input string and the search will be carried out on the 
modules available in the project. The user can insert the full name or part of it. 
 
 

 How to manage the filters in the Signals window 

The signals can be sorted or filtered by Filter options: by clicking on the   icon, the filter options panel 
will be opened: only the signals specified by the filters will be displayed. 
 
The available filters are shown in the top of the Signals window: see the red rectangle in the picture below:  
 

 
 
When the option panel is shown, the following filters are available. The filters can be used individually or 
can be mixed:    
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Only used signals: 
Only the signals already used in at least one function are presented and they are highlighted in blue: 
 

 
 
 
Only signals in highlighted modules: 
When this filter option is selected, only the signals belonging to the highlighted modules are shown in the 
Signals window. 
See the example below: 
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Group by module: 
The signals are grouped by their own module, as shown in the example below: 
 

 
 
Group by location: 
The signals are grouped by location. 
 

 
 
Search box: 
The results will include all the words that contain the input string and the search will be carried out on the 
modules available in the project. The user can insert the full name or part of it. 
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 Import module list from Template file function 

The user can create the UWP 3.0 configuration in a faster way, reducing the time required to create the 
modules list. The time needed to specify customized names of modules and signals will be reduced. The 
function is available in the File menu of the UWP 3.0 Tool (the function is not available in the SA Tool 
version). 
 

 
 
The user defines the modules and signals in a Template file. Customized names for modules and signals 
can be specified in order to override the default names provided by the UWP 3.0 Tool. The modules and 
signals list will be imported by an excel file provided by the UWP 3.0 Tool: when a new version of the 
software is released, the UWP 3.0 Tool embeds a new version of the file to manage new modules.  

 How to download the Template file 

From the File menu of the UWP 3.0 Tool, click the Import module function, then select the Get Excel 
template file option: 
 

 
In the Save As window that will appear, the user has to locate the target directory to download the 

template file. 

 

 



 

 

UWP 3.0 tool manual  

60 

 

 

 Template file overview 

The Template file is in XLSM format: the file is editable by the user with Microsoft ® Office 2007 or later. 
The example below shows the file structure of an inserted module: the cells highlighted in green are 
editable, while the cells highlighted in red must not be modified, otherwise the file will not be imported 
successfully: 

 
The descriptions of all the fields are shown below: 
 

Field name Description 

Barcode 

The barcode can be scanned by a barcode scanner or typed manually: the 

fields such as PartNumber, Sin (A, B, C) and signals are automatically filled in 

with the moduleôs information 

PartNumber 

The PartNumber can be entered manually or automatically: 

The fields Sin (A, B, C) and signals are automatically filled in with the moduleôs 

information  

SinA, SinB, SinC 
These fields are automatically filled in when a valid barcode is scanned. 
When the PartNumber is inserted manually, the user must complete the fields 
Sin A, B, C with the SIN of the module 

ModuleName 
The user can enter a customized name instead of the Module name that is 
automatically assigned by the UWP 3.0 Tool  

Location path 

The user can enter a customized location path, using the ñ\ò symbol between 
each nesting location (e.g. Floor1\ Room1). The base path ñRoot\ò will be 
added automatically to the project when the Template file is imported 
 
Note: the ñ\ò symbol is not a valid character for a location name 

Type (In, Out, Dia) These fields are automatically filled in according to the number of signals 

provided by the PartNumber 

Note: these fields must not be modified by the user # (Number) 

SignalName 
The user can enter a customized name instead of the Signal name that is 
automatically assigned by the UWP 3.0 Tool 

 
The fields marked in bold are mandatory. 
 
 
  

Barcode PartNumber SinA SinB SinC ModuleName Location path Type # SignalName 

00204507800016 B4X-LS4-U 002 045 078   In 1  

       In 2  

       Out 3  

       Dia 4  
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 How to find the barcode to be inserted 

 
The barcode is present on different labels attached to the box: this information can be found on the upper-
box label and on the inside label, as shown below: 
 

                  
 

 
 
The part numbers that will be managed in the Template file are listed here: other modules will not be 
recognized by the file and marked as NONE part number. 
 

Part Number Description 

SBB4I2O24 Fire damper I/O module 

SBB4I2O230 Fire damper I/O module 

BDB-INCON4-U Decentral modules with 4 contacts inputs 

BDB-INCON8-U Decentral modules with 8 contacts inputs 

BDB-IOCP8-U Decentral modules for 4 push buttons and 4 outputs for LED 

BDB-IOCP8A-U Decentral modules for 4 push buttons and 4 outputs for LED 

BDA-RE13A-U Decentral relay output 

SH2RE16A4 Output relay module with 4 outputs 

SH2INDI424 Input module for 4 inputs 

B4X-LS4-U Light switch with 4 push buttons and 4 LEDs 

B5X-LS4-U Light switch with 4 push buttons and 4 LEDs 

SHA4XLS4TH Light switch with 4 push buttons and 4 LEDs with temperature and humidity 

SHE5XLS4TH Light switch with 4 push buttons and 4 LEDs with temperature and humidity 

SHSQP360L PIR sensor with an integrated Luxmeter  
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 Compile the Template file with Microsoft Excel  

The Template file is delivered in macro-enabled workbook format (.xlsm). After downloading the 
Template file, open it with Microsoft Office 2007 or a later version. This is necessary to enable the macro 
content. 

i. How to enable Excel macros 

If the yellow Message Bar appears with a shield icon, the user has to click on the Enable Content button 
to enable the macro content, as shown in the red rectangle below: 
 

 
 
For more details please visit: Enable or disable macros in Office files 
 
 
There are two ways to compile the template file with modules, as shown in the following pages: 
 

Á Automatic insertion with a barcode scanner; 
 

Á Manual insertion by the user (by a keyboard); 
  

https://support.office.com/en-US/Article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6?ui=en-US
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 Automatic insertion with a barcode scanner 

 
A barcode scanner is used to scan the barcodes and the Template file is automatically filled in with the 
module information. The procedure is as follows: 
 

System requirements 

Hardware 

A barcode scanner 

Note: the barcode scanner has to be configured to send only one CRLF or Enter 

key after the barcode scan. Please refer to Barcode scanner documentation 

Software 

UWP 3.0 Tool 7.5.3 or later (the SA Tool version is not supported) 

Microsoft ® Excel 2007 or later 

Note: Excel macros must be allowed by security policies 

 
1. The user opens the Template file: the active cell in the Excel workbook is focused on the first 

barcode cell, as shown in the red rectangle below: 
 

Barcode PartNumber SinA SinB SinC ModuleName Location path Type # SignalName 

          

 
2. A barcode is scanned by a barcode scanner: the barcode is entered in the relevant cell, as shown 

below: 
 

Barcode PartNumber SinA SinB SinC ModuleName Location path Type # SignalName 

AAABBBCCCDDEE          

          

 
3. If the barcode is valid, it is recognised and the PartNumber and the Sin cells are automatically 

filled in with the module information (green rectangle below): 
 

Barcode PartNumber SinA SinB SinC ModuleName Location path Type # SignalName 

AAABBBCCCDDEE PRTNMB001 AAA BBB CCC      

          

 
4. Likewise with step 3, the cells Type and # are automatically filled in according to the number of 

signals provided by the PartNumber (blue rectangle below). The active cell in the excel workbook 
is moved automatically to the next available cell in the Barcode column (orange rectangle below): 

 

Barcode PartNumber SinA SinB SinC ModuleName Location path Type # SignalName 

AAABBBCCCDDEE PRTNMB001 AAA BBB CCC   In 1  

       In 2  

       Out 3  

       Dia 4  

          

 
5. The options fields such as ModuleName, LocationPath and SignalName can be filled in by the user 

in the relevant cells on the Template file. Repeat steps 1 to 5 for every other module which has to 
be inserted. 
 

6. Click on the Save button in the Excel program to save the changes. The file is now ready to be 
imported. 
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 Manual insertion without a barcode scanner 

The template file can be manually filled in by the user. The requirements are shown below: 
 

System requirements 

Hardware Keyboard 

Software 

UWP 3.0 Tool 7.5.3 or later (the SA Tool version is not supported) 

Microsoft Excel 2007 or later 

Note: Excel macros must be allowed by security policies 

 
The procedure is as follows: 
 
1. The user opens the Template file: the active cell on the Excel worksheet is the first valid Barcode cell 

(red box below). The barcode can be entered manually by the user: if the barcode is recognised, the 
module information will be automatically filled in, as in the previous procedure: 

 
Barcode PartNumber SinA SinB SinC MouleName Location path Type # SignalName 

          

 
2. In a different way, the user can select the first valid PartNumber cell and type the part number of the 

module has to inserted. 
Note: the part number must be inserted in capital letter (e.g. SHA5XLS4TH is correct, sha5xls4th is not recognized)  
 

Barcode PartNumber SinA SinB SinC MouleName Location path Type # SignalName 

 PRTNMB001         

          

 
3. After pressing enter, the cells Type and # are automatically filled in according to the number of signals 

provided by the PartNumber (blue rectangle below). These fields must not be edited. 
 

Barcode PartNumber SinA SinB SinC MouleName Location path Type # SignalName 

 PRTNMB001      In 1  

       In 2  

       Out 3  

       Dia 4  

 
4. The user has to insert the Sin number in the Sin (A, B, C) fields (red box below): 

 

Barcode PartNumber SinA SinB SinC MouleName Location path Type # SignalName 

 PRTNMB001 AAA BBB CCC   In 1  

       In 2  

       Out 3  

       Dia 4  

          

 
5. The user has to select the first active cell in the Barcode column (orange rectangle above) Repeat 

steps 1 to 7 for every other module which has to be inserted. 
 

6. Click on the Save button in the Excel program to save the changes. The file is now ready to be 
imported. 
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 How to import a fulfilled Template file 

To import a Template file, the user has to click on the Import module button in the File menu of the 
UWP 3.0 Tool and select the Import Excel file option (see below): 
 

 

 

The Import module signals window will appear: 

 

 

 

In the Subnet list in the window, the user has to select which Subnet the modules have to be attached 

to: only the SH2MCG24 Master Channel Generator is allowed. One file permits specification of the 

modules attached to only one network. To manage multiple Subnets, one Template file has to be created 

for each Subnet of the project. 

 

By clicking on the  button, the user locates the Template file which has to be imported in the project: 

only XLSX/XLSM file extensions are allowed: the XLS format will not be supported. 
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By clicking on the Confirm button to process the file: the system starts to check the Template file for data 
consistency. If there are no errors the user can click on the Confirm button to import the modules/locations 
as defined in the Template file: 
 
In the UWP 3.0 Tool each part number is added in the Module view and located in the location tree 
according to the Location path value. 
 
The name of the module is replaced with the one specified in the Template file or automatically assigned 
by the UWP 3.0 Tool if left blank. The signals names are replaced with the customized values or 
automatically assigned by the UWP 3.0 Tool.  

 How to fix a Template file with errors 

 
If there are some errors on the Template file, the user cannot confirm the importing of 

modules/locations: the user can close the Import module signals window or click on the  button to 
open a different Template file. 
 
In the Import module signals window, for each row that is not valid, a message will be shown to give 

information about the row number and the related errors that will guide the user in fixing the error. 

 

 
 
 
The user can repeat the procedure above to import the fixed Template file. 
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 Light switches 

The following items belong to the Light switches family: 
 
B4X-LS4-U 
B5X-LS4-U (this item also has to be selected for B5B-LS4-U and B5W-LS4-U) 
BEW-LS1-U 
BEW-LS2-U 
BEW-LS3-U 
BEW-LS4-U (this item also has to be selected for BEA-LS4-U and BEG-LS4-U) 
SHA4XLS4P90L (this is a light switch with integrated PIR sensor and Luxmeter) 
SHE5XLS4P90L (this is a light switch with integrated PIR sensor and Luxmeter) 
 
 
 
To configure these, click on the relevant picture once they are added to the project: 

 
 
  
 
 
The configuration wizard will appear: 
 

 
 
 
In the Input signals field, the Long activation and the Very long activation time has to be defined. 
The Long activation time can be set from 1 to 5 seconds, while the Very long activation time can be set 
from 0.5 to 15 seconds and it is always set by the system 3 seconds longer than the Long activation time. 
The short press and long press are recognized when the push button is released.  
The user can configure different times for each push button or can set them to the same values by clicking 
on Apply to all. 
If the Very long activation time is set shorter than 4 seconds, the long press is disabled: in this situation, 
the function associated to the very long press will be activated as soon as the pushbutton is pressed for 
the selected time. 
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In the Output signals window, the user can enable the white LED as a guide light (red rectangle): by 
clicking on the white LED icon, the guide light is enabled, while by clicking on the red cross the guide light 
is not enabled. 
Each LED can have different behaviour. 
The guide light is configurable in the following items: B4X-LS4-U, B5X-LS4-U and the brightness can be 
set in the Properties window. 
 

 
 
 
 

  
















































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































